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Pertemuan 1 : Membuat Font dengan Font Forge

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat Font sendiri menggunakan aplikasi opensource
FontForge.

B. MATERI:

Teks sudah digunakan sekitar 6000 tahun yang lalu di mesir dengan

menggunakan simbol-simbol tertentu, hal ini dapat kita lihat pada peninggalan

Piramida di Mesir. Kata maupun simbol dalam bentuk apapun mampu menyampaikan

makna dan dapat dipahami oleh sebagian besar orang. Pada Abad ke 15, Johan

Gensfleisch zum Gutenberg membuat mesin tik bergerak sebagai pencetak teks.

Penemuan ini merupakan awal dari percetakan dan dimulainya produksi besar-

besaran satu salinan yang sama.

Font Merupakan kumpulan karakter dari suatu ukuran dan jenis yang dimiliki

oleh keluargga typeface tertentu. Typeface merupakan keluarga dari karakter grafis

yang menyertakan banyak ukuran dan jenis. FontForge merupakan aplikasi gratis

bebas untuk digunakan tanpa membeli yang dapat anda pakai untuk membuat font.

C. PRAKTIKUM

Silahkan buka aplikasi FontForge, setelah terbuka pilih menu New seperti yang
terlihat pada gambar dibawah ini.



Muncul halaman yang memperlihatkan angka huruf serta simbol yang nantinya bisa
kita bikin, silahkan pilih dengan klik 1x kotak X dibawah huruf A kapital, lalu klik
kanan dan pilih New Outline Window seperti yang terlihat pada gambar di bawah ini.

Setelah dipilih anda pilih akan muncul halaman seperti halaman berikut ini,
perhatikan pojok kiri atas ada huruf A, itu menandakan bahwa anda akan membuat
font untuk huruf A.

Kalian bisa membuat font sendiri dengan menggunakan tool dari FontForge secara
langsung atau kalian bisa membuat font berdasarkan referensi yang sudah ada.



Caranya dengan meng-import gambar font yang berasal dari gambar yang memiliki
free licence, saya sertakan gambar font yang nanti bisa kalian gunakan. Berikut cara
untuk meng-import gambar, silahkan klik menu file pojok kiri atas, lalu pilih menu
import seperti yang terlihat pada gambar di bawah ini.

Agar lebih mudah, letakkan gambar yang kalian ingin import di folder documents
agar lebih mudah dalam mencarinya, pilih salah satu gambar misalnya gambar huruf
A, lalu klik import dan nanti akan muncul menu anda bisa skip langsung ok saja.

Gambar yang anda pilih akan tampil dan anda bisa menggeser posisi gambar dengan
memilih back yang ditunjukkan tanda panah merah, jadi ada 2 layer back dan fore,
back posisi di bawah dan fore posisi di atas, kita asumsikan back sebagai gambar
yang akan kita salin bentuknya.



Sekarang kalian siap untuk membuat font huruf A yang nanti akan anda gambar
menggunakan fitur bawaan FontForge, sekarang pilih add a curve point seperti yang
terlihat pada gambar berikut ini.

Kursor akan berubah setelah anda mengklik add a curve point, Pilih Fore terlebih
dahulu, sekarang arahkan kursor ke pinggir gambar font yang kalian import tadi, klik
sedikit demi sedikit dan bikin garis mengelilingi tiap sudut dari gambar font tersebut,
serta kalian harus menyatukan klik terakhir dengan poin pertama saat membuat klik
pertama (dibuat agar menyambung).



Setelah menyatukan titik mengelilingi bentuk font, anda bisa melihat hasilnya dengan
memilih menu Window lalu pilih New Metrics Window seperti yang terlihat pada
gambar di bawah ini

Setelah memilih New Metrics Window, Hasil Font yang kalian buat tadi akan
ditampilkan seperti yang terlihat pada gambar di bawah ini.



Font huruf A telah berhasil dibuat, ulangi langkah-langkah sebelumnya untuk
membuat huruf yang lain, berikut hasil 26 huruf kapital yang telah dibuat.

Sebelum disave, silahkan beri nama font anda dengan memilih menu Element yang
akan menampilkan tampilan menu sebagai berikut.



Silahkan beri nama yang sesuai menurut kalian, saya memakai nama Fontgear,
setelah memberi nama silahkan tekan tombol OK. Langkah selanjutnya pilih menu
File lalu pilih Generate Fonts seperti yang ditampilkan gambar di bawah ini.

Silahkan pilih true tipe seperti yang terlihat pada gambar dibawah ini. Jangan lupa
pilih lokasi hasil generate agar kalian mudah menemukan file hasil generate.



Silahkan tekan Generate, jika terdapat pesan error seperti gambar di bawah ini, kalian
bisa abaikan dengan menekan tombol generate

Silahkan cari hasil generatenya berupa nama file sesuai dengan nama font yang kalian
buat pada langkah sebelumnya.



Double klik file tersebut untuk menginstal font seperti yang terlihat pada gambar di
bawah ini.

D. LATIHAN
1. Silahkan bikin Font dari A-Z

2. Screenshot proses kerja bikin font salah 1

3. Screenshot hasil Font A-Z



Pertemuan 2 : Mengolah suara dengan Audacity

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu mengolah suara dengan menggunakan aplikasi Audacity.

B. MATERI

Penggunaan sound atau suara dalam sebuah multimedia menjadi suatu bagian yang
sangat penting dan tidak boleh diabaikan, berikut alasan penggunaan suara dalam
sebuah multimedia.

 Percakapan atau Speech merupakan komunikasi interaktif antara dua atau lebih
orang. Komunikasi yang terjadi disebut juga dengan dialog. contoh
penggunaannya adalah di dalam film.

 Musik Latar adalah suara mengandung irama dan lagu yang dapat menghasilkan
efek yang lebih dramatis, misalnya multimedia dengan tema ceria didukung
dengan alunan musik yang ceria.

 Narasi digunakan sebagai penjelasan suatu keadaan atau kejadian di dalam
produk multimedia contohnya narasi dalam iklan air minum.

 Efek Suara penggunaan efek suara di dalam sebuah multimedia seperti suara
pedang yang diadu, suara petir dan suara lolongan serigala.

C. PRAKTIKUM

Silahkan buka aplikasi Audacity, berikut tampilan aplikasi Audacity seperti terlihat
pada gambar di bawah ini.



Siapkan dulu rekaman suara kalian dengan menggunakan rekaman suara di
smartphone, silahkan convert file hasil rekaman suara kalian menjadi format .wav
atau .mp3 terlebih dahulu. Jika sudah siap buka file rekaman suara kalian tadi dengan
memilih menu berkas di bagian pojok kiri atas, lalu pilih buka seperti yang terlihat
pada gambar di bawah ini.

Setelah dipilih salah satu rekaman suara kalian, maka akan tampak tampilan seperti
gelombang suara seperti yang ditunjukkan pada gambar dibawah ini.



Jika kita merekam suara dan menemukan ada suara yang tidak diinginkan atau ada
suara noise, kita bisa mengurangi atau menghilangkan suara yang tidak diinginkan
tersebut. Pada rekaman suara yang diuji pada pembuatan modul ini, terdapat suara
tarikan nafas saat membaca narasi, suara tarikan nafas dapat dilihat gelombang kecil
yang ditunjukkan panah warna merah pada gambar di bawah ini.

Silahkan blok gelombang kecil yang menunjukkan suara noise atau suara yang tidak
diinginkan dengan klik ujung gelombang kecil tekan terus mouse lalu geser ke arah
kanan seperti yang terlihat pada gambar di bawah ini.



Setelah diblok suara yang ingin dihilangkan silahkan pilih Efek lalu pilih Noise
Reduction seperti yang terlihat pada gambar di bawah ini.

Setelah terbuka pilih Get Noise Profile, setelah tertutup kotak dialognya, klik tombol
pilih yang akan menjadikan gelombang suara menjadi lebih terang yang menandakan
gelombang suara telah ditandai semua, seperti yang terlihat pada gambar di bawah ini.

Klik lagi Efek lalu Noise reduction, kali ini langsung klik OK, dan berikut hasil dari
proses pengurangan noise yang ditunjukkan bahwa gelombang kecil yang ditunjukkan
panah warna merah sudah semakin kecil/menghilang gelombangnya suaranya.



Kalian bisa menggunakan efek agar suara kalian seperti berada di suatu ruangan,
misalnya ruang studio, silahkan pilih menu Efek lalu pilih menu Reverb, setelah
terbuka silahkan atur nilai pengaturannya, anda bisa menyesuaikan nilai
pengaturannya seperti gambar di bawah ini.

D. LATIHAN

1. Buatlah rekaman suara dengan menggunakan hp saja, sholawatan atau membaca
sebuah narasi kira2 10 - 30 detik saja.

2. Hilangkan noise suara rekaman anda serta bikin efek untuk suara rekaman anda.

3. Screenshot langkahnya dalam sebuah laporan.



Pertemuan 3 : Pengolah Gambar GIMP

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu menginstal dan membuat tampilan menyerupai Adobe Photoshop
di aplikasi GIMP.

B. MATERI

Menurut KBBI, Gambar adalah tiruan barang (orang, binatang, tumbuhan, dan
sebagainya) yang dibuat dengan coretan pensil dan sebagainya pada kertas dan
sebagainya; lukisan;

Gambar Digital adalah gambar yang sudah dalam bentuk format digital yang
diperlukan perangkat khusus untuk melihat gambar tersebut. Dikutip dari
encyclopedia.com: gambar digital merupakan representasi dari gambar nyata sebagai
sekumpulan angka yang dapat disimpan dan ditangani oleh komputer digital. Untuk
menerjemahkan gambar menjadi angka, gambar dibagi menjadi area kecil yang
disebut piksel (elemen gambar). Untuk setiap piksel, perangkat pencitraan merekam
sebuah angka, atau sekumpulan kecil angka, yang menjelaskan beberapa properti
piksel ini, seperti kecerahannya (intensitas cahaya) atau warnanya. Angka-angka
tersebut disusun dalam larik baris dan kolom yang sesuai dengan posisi vertikal dan
horizontal piksel pada gambar.

GNU Image Manipulation Program atau yang lebih dikenal dengan
sebutan GIMP adalah perangkat lunak untuk manipulasi grafik berbasis raster. GIMP
adalah aplikasi sumber terbuka untuk mengolah grafis Bitmap. GIMP dapat
dimanfaatkan untuk membuat grafik dan logo, mengubah resolusi dan memotong foto,
mengubah warna, menggabungkan berbagai macam gambar atau mengkonversi
berbagai macam jenis berkas gambar (wikipedia).

C. PRAKTIKUM

SIlahkan download dulu installer GIMP versi 2.10.20 di gimp.org/downloads/

https://id.wikipedia.org/wiki/Grafik


Setelah diinstal silahkan buka aplikasi GIMP, berikut adalah tampilan awal GIMP,
kita akan coba membuat tampilan GIMP agar terlihat seperti tampilan Adobe
Photoshop.

Silahkan pilih Windows > Single-Window Mode seperti yang terlihat pada gambar
di bawah ini, lalu kalian close dulu aplikasi GIMP terlebih dahulu.



Silahkan ekstrak Patch Adobe Photoshop .zip (download filenya ada disini:
https://github.com/Diolinux/PhotoGIMP.git ) yang telah disertakan dengan modul ini,
hasil ekstrak berupa folder dengan nama 2.10 seperti yang terlihat pada gambar di
bawah ini.

Sekarang pilih View pada file explorer kalian, silahkan tambahkan centang pada
bagian Hidden items seperti yang terlihat pada gambar di bawah ini. Hal ini
dimaksud agar folder AppData muncul karena folder tersebut disembunyikan secara
default oleh sistem.

https://github.com/Diolinux/PhotoGIMP.git)


Setelah itu silahkan masuk ke C: > Users > Nama_user > AppData > Roaming >
GIMP disitu terdapat folder dengan nama 2.10 silahkan kalian hapus folder tersebut
seperti yang terlihat pada gambar di bawah ini.

Silahkan pindah folder hasil ekstrak pada langkah sebelumnya, dan taruh di folder
C: > Users > Nama_user > AppData > Roaming > GIMP yang dihapus folder 2.10
sebelumnya. Sekarang kalian buka kembali dan tampilan GIMP sudah menyerupai
tampilan Adobe Photoshop seperti yang terlihat pada gambar di bawah ini.



D. LATIHAN

1. Instal aplikasi GIMP.

2. Instal Patch Adobe Photoshop.

3. Screenshot langkahnya dalam sebuah laporan.



Pertemuan 4 : Membuat Cover Dengan GIMP

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat cover buku menggunakan aplikasi GIMP.

B. MATERI

Seperti yang dikutip di website http://photoshopdesain.com Gradient tool merupakan
tool yang digunakan untuk mengisi objek dengan gradiasi warna. Ada banyak tipe
Gradiasi yang disediakan Photoshop untuk kita gunakan. Tipe gradiasi warna yang
dapat kita digunakan antara lain yakni:

Linear gradient = Untuk membertuk gradiasi warna dengan pola gradiasi berbentuk
garis lurus.

Radial Gradient = Untuk membetuk gradiasi warna dengan pola gradiasi berbentuk
sebaran warna melingkar.

Angular Gradient = Untuk menbentuk gradiasi warna dengan pola gradiasi
berbentuk melingkar.

Reflected Gradient = Untuk membentuk gradiasi warna dengan pola gradiasi
berbentuk garis lurus yang terefleksi /

dicerminkan.
Diamond Gradient = Untuk membentuk gradiasi warna dengan pola gradiasi yang

memusat berbentuk segi empat.

C. PRAKTIKUM

Silahkan buka situs penyedia layanan free image, disini saya membuka situs
www.pexels.com, silahkan ketik pencarian dengan kata kunci “library”, pilih salah
satu gambar yang nanti kalian gunakan sebagai cover buku nantinya.

http://photoshopdesain.com
http://www.pexels.com,


Setelah memilih salah satu gambar maka akan menampilkan informasi tentang
gambar tersebut dan kalian bisa mendownload gambar tersebut (klik tanda panah di
sebelah tulisan Unduh Gratis). SIlahkan klik info untuk mengetahui lisensi dari
gambar tersebut.

Silahkan pilih File terus pilih New dan pada bagian template silahkan pilih A5, jadi
kita akan mencoba membuat cover untuk buku ukuran A5. pilih latar belakang warna
hitam seperti yang ditunjukkan oleh tanda panah.



Silahkan tekan ctrl+alt+O untuk memasukkan gambar sebagai layer ke 2. Silahkan
tekan ctrl+T untuk mengatur skala gambar sehingga tampilan seperti yang terlihat
pada gambar di bawah ini.

Pilih Move Tool yang posisinya dibawah tulisan File untuk mengatur posisi gambar
agar lebih pas. Kalau sudah pas silahkan klik kanan pada layer yang ditunjukkan
panah pada gambar di atas. Lalu pilih Add Layer Mask langsung tekan Add seperti
yang terlihat pada gambar di bawah ini.



Setelah itu pilih hasil layer mask tadi, lalu tekan G untuk mengaktifkan tool gradient,
arahkan kursor dari tepi gambar yang berwarna hitam ke arah atas agar menampilkan
efek gradient seperti yang terlihat pada gambar di bawah ini.

Setelah berhasil silahkan klik kanan pada bagian yang ditunjuk panah pada gambar di
atas ini, lalu pilih Apply Layer Mask, ulangi lagi langkah Add Layer Mask lalu
ganti bagian atas yang kalian bikin efek gradient seperti yang terlihat pada gambar di
bawah ini.



Silahkan kalian tulisan dengan menggunakan Text Tool dengan menekan T,
masukkan lagi gambar untuk membuat efek overlay, silahkan tekan ctrl+alt+O untuk
memilih gambar, lalu sesuaikan ukuran gmbar dengan menekan ctrl+T seperti yang
terlihat pada gambar di bawah ini.

Pada bagian Mode seperti yang ditunjukkan panah pada gambar di atas, silahkan
ganti normal menjadi Overlay. Hasilnya akan membuat warna menjadi berbeda
seperti yang terlihat pada gambar di bawah ini.



D. LATIHAN

1. Silahkan bikin sebuah cover buku.

2. Tidak harus ikuti langkah yang ada di modul.

3. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 5 : Membuat Video Dengan Openshot

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu melakukan editing video sederhana dengan aplikasi Openshot.

B. MATERI

Berasal dari kata latin yang berarti “saya lihat”. Video adalah teknologi pemrosesan
sinyal elektronik yang mewakilkan gambar bergerak. Aplikasi umum dari teknologi
video adalah televisi, sedangkan untuk jaman sekarang ini ada banyak platform video
online yang populer seperti youtube, Tik Tok, Netflix. Video merupakan suatu media
yang berasal dari rekaman visual yang bergerak dengan durasi tertentu.

OpenShot Video Editor adalah editor video gratis dan open source untuk Linux,
macOS, dan Windows. Proyek ini dimulai pada Agustus 2008 oleh Jonathan Thomas,
dengan tujuan menyediakan editor video yang stabil, gratis, dan ramah untuk
digunakan (wikipedia).

C. PRAKTIKUM

Silahkan buka situs openshot.org, klik tombol download v2.5.1 seperti yang terlihat
pada gambar di bawah ini.

Setelah kalian instal silahkan buka aplikasi Openshot, sesuaikan tampilan Openshot
dengan menggeser tanda …… seperti yang ditunjukkan tanda panah pada gambar di
bawah ini.



Setelah mengatur tampilan, silahkan memulai edit video, sebelumnya sediakan 3
video, cukup video hasil rekaman smartphone kalian, Tiap video cukup durasi 5
sampai 15 detik. Selanjutnya silahkan pilih File > Import File untuk memasukkan ke
3 video ke dalam project seperti yang terlihat pada gambar di bawah ini.

klik atau tarik video lalu masukkan ke dalam Track 1 seperti yang terlihat pada
gambar di bawah ini.



Langkah selanjutnya memberikan transisi pada perpindahan scene video agar terlihat
lebih menarik, klik menu Transitions dan pilih salah satu efek transisi lalu tarik dan
letakkan ditengah2 antara perpindahan video seperti yang terlihat pada gambar di
bawah ini.

Agar efek transisi berjalan cepat silahkan atur lebar efek transisi yang berwarna biru
dengan mengecilkannya, untuk melihat hasil efek transisi silahkan tekan tombol play
pada video seperti yang terlihat pada gambar di bawah ini.



Masukkan audio backsound suara alam contohnya suara kicau burung bisa dicari di
tautan ini https://www.edinburghrecords.com/free-sound-effects/, caranya sama
seperti memasukkan video ke dalam project, tarik audio dan masukkan ke dalam track
2 seperti yang terlihat pada gambar di bawah ini.

Jika durasi sound lebih panjang dari video, kalian potong dengan menggunakan fitur
Razor Tool, sesuaikan panjang sound dan panjang video agar bareng saat berhenti
diputar, setelah dipotong silahkan delete durasi sisa sound seperti yang terlihat pada
gambar di bawah ini. Untuk menonaktifkan fitur Razor Tool, klik kembali fitur
tersebut agar tidak aktif.



Langkah selanjutnya silahkan export video dengan memilih menu File > Export
Project > Export Video, setelah itu sesuaikan setting video kalian (Folder Path
sesuaikan sendiri tempatnya) seperti gambar di bawah ini.

Klik Export Video dan tunggu sampai selesai diproses, hasil export video berada
sesuai lokasi Folder Path.

D. LATIHAN

1. Silahkan bikin record video dengan smartphone minimal 3 video.

2. Gabungkan ke 3 video tersebut dan berikan efek atau transisi

3. Tidak harus ikuti langkah yang ada di modul.

4. Screenshot langkahnya dalam bentuk laporan.

Delete bagian ini



Pertemuan 6 : Membuat Animasi Sederhana Blender 3D

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat animasi sederhana dengan aplikasi Blender.

B. MATERI

Blender software pengolah animasi 3D yang open source sehingga anda bebas
mengggunakan. Walaupun open source tetapi Blender memiliki banyak fitur dan juga
kemampuan yang bisa anda manfaatkan untuk membuat animasi.

Berikut tool utama untuk mengoperasikan obyek 3D di aplikasi blender

Select Box : digunakan untuk memilih obyek 3D

Cursor : digunakan untuk meletakkan kursor di dalam obyek 3D

Modus : digunakan untuk menggeser obyek 3D

Rotasi : digunakan untuk memutar obyek 3D

Adegan : digunakan untuk merubah ukuran obyek 3D

Orientasi Transformasi : digunakan untuk memutar dan merubah ukuran obyek 3D

Annotate : digunakan untuk membuat garis

Measure : digunakan untuk mengukur jarak

C. PRAKTIKUM

Silahkan buka aplikasi Blender yang telah kalian instal, berikut antarmuka aplikasi
pengolah animasi 3D yang opensource.



Untuk melihat sudut pandang dari berbagai sisi silahkan tekan dan tahan roda scroll
pada mouse kalian lalu geser mouse untuk melihat secara memutar obyek 3D

Baik kita mulai membuat animasi sederhana, silahkan klik Dokumen/File lalu pilih
Baru/new, kita ubah dulu bentuk box default nya, silahkan tekan S dan X di keyboard
secara bersamaan, lalu mouse gerakkan sehingga membentuk box panjang seperti
gambar di bawah ini.



Setelah itu silahkan pilih menu Baru > Mesh > Plane seperti yang terlihat pada
gambar di bawah ini.

Plane ini nanti digunakan sebagai alas atau penompang dari obyek 3D, silahkan ubah
ukuran plane terlebih dahulu, caranya pastikan anda memilih plane terlebih dahulu,
lalu pada bagian tool utama silahkan diaktifkan dulu fitur adegan seperti yang terlihat
pada gambar dibawah ini.



Silahkan tarik garis warna hijau atau merah agar ukuran plane membesar seperti yang
terlihat pada gambar di bawah ini.

Atur lagi plane dan box agar terlihat sesuai, letakkan box panjang tepat diatas plane,
atur dengan menggunakan tool move sehingga terlihat seperti gambar di bawah ini.



Silahkan buat 1 box yang berada tepat di atas plane, pilih Baru > Mesh > Cube
seperti yang terlihat pada gambar di bawah ini.

Silahkan pilih cube.001 atau cube yang baru dibuat tadi, silahkan pilih menu Physics
Properties seperti yang ditunjukkan tanda panah pada gambar di bawah ini.



Silahkan pilih Rigid Bodi dan set seperti gambar di bawah ini.

Sekarang ganti pilih bagian plane, dan set Physics Properties seperti gambar di
bawah ini.



Sekarang ganti pilih bagian box panjang, dan set Physics Properties seperti gambar
di bawah ini.

Setelah semua telah diset, sekarang saatnya membuat animasi, cobalah play dulu
animasinya, saat kotak sudah jatuh, klik N lalu klik i seperti yang terlihat pada gambar
dibawah ini.



Pada gambar diatas digunakan untuk menentukan lokasi awal dari box panjang,
sekarang geser ujung durasi menuju ke 160 seperti gambar di bawah ini, baru geser
kotak panjang (tekan G dan Y lalu mouse arahkan ke kiri) menuju ke kiri sampai
ujung.

D. LATIHAN

1. Silahkan buat 4 buah kotak dengan berat massa yang berbeda.

2. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 7 : Membuat Modeling Buku di Blender 3D

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat obyek 3D buku dengan aplikasi Blender.

B. MATERI

Modeling adalah proses pembuatan model objek dalam bentuk 3D di komputer.
Model bisa berupa karakter, tumbuhan, rumah, mobil, peralatan, dan lain-lain. Model
harus dibuat dengan detail dan sesuai dengan ukuran dan skala desain yang telah
ditentukan sebelumnya sehingga objek model akan tampak ideal dan proporsional
untuk dilihat.

Pada proses modeling dibutuhkan ketelitian dan kerapian bentuk model 3D, semakin
bagus bentuk model 3D maka hasil dari animasi juga akan ikut bagus. Proses
modeling juga merupakan proses awal dalam merancang sebuah animasi 3D.

C. PRAKTIKUM

Silahkan buka aplikasi Blender, silahkan ubah box menjadi kotak seperti gambar
dibawah ini dengan menggunakan tool scale.

Sesuaikan ukuran kotak sehingga proposional seperti ukuran sebuah buku, silahkan
select kotak tersebut, lalu klik tombol tab pada keyboard anda dan warna kotak
menjadi seperti gambar di bawah ini.



Lalu Klik menu Loop Cut , posisikan irisan ke kotak seperti yang terlihat pada
gambar di bawah ini, Loop Cut ini membagi kotak menjadi 2 bagian atas dan bawah.

Setelah membagi kotak menjadi 2 bagian, silahkan klik angka 2 pada keyboard lalu
pilih tool Move, posisikan kursor seperti pada gambar di bawah ini.



Silahkan geser panah warna hijau dan bentuk kotak menjadi seperti gambar di bawah
ini.

Sekarang tekan pada keyboard anda ctrl + B secara bersamaan, tekan juga mouse anda
bagian pada bagian tengah atau roda, dan arahkan mouse anda ke kanan sehingga
obyek kotak membentuk pola sudut melengkung seperti gambar di bawah ini.



Langkah selanjutnya, tekan angka 3 pada keyboard, lalu tekan huruf C setelah itu klik
sisi seperti yang terlihat pada gambar di bawah ini.

Setelah itu klik kanan dulu untuk menonaktifkan tombol C tadi, lalu klik tengah
mouse atau roda mouse untuk memutar obyek kotak, lakukan langkah yang sama
dengan menekan tombol C lagi lalu klik sisi tersebut seperti yang terlihat pada
gambar di bawah ini.



Setelah itu klik kanan dulu untuk menonaktifkan tombol C tadi, lalu klik tengah
mouse atau roda mouse untuk memutar obyek kotak, lakukan langkah yang sama
dengan menekan tombol C lagi lalu klik sisi tersebut seperti yang terlihat pada
gambar di bawah ini.

Jadi ada 3 sisi yang telah dikasih tanda, langkah selanjutnya klik kanan agar Tombol
C sudah tidak aktif, selanjutnya klik tombol i, dan arahkan kursor ke kanan, sesuaikan
agar menjadi pola seperti gambar di bawah ini.



Setelah menjadi pola seperti gambar di atas, silahkan klik tombol S pada keyboard
arahkan kursor agar membuat pola seperti gambar di bawah ini.

Setelah jadi bentuk obyek seperti gambar di atas, silahkan klik lagi tombol C dan klik
sisi tersebut untuk menghilangkan garis seperti gambar di bawah ini.



Klik kanan pada mouse dulu untuk menonaktifkan tombol C, setelah itu tekan tombol
F untuk menghilangkan garis-garis seperti yang terlihat pada gambar di bawah ini.

Rapikan agar terlihat seperti obyek buku 3D seperti yang terlihat pada gambar di
bawah ini.



D. LATIHAN

1. Silahkan buat obyek 3D buku.

2. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 8 : Texturing Buku di Blender 3D

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat texturing obyek buku dengan aplikasi Blender.

B. MATERI

Texturing adalah proses pembuatan dan pemberian warna dan material (texture) pada
objek yang telah dimodelkan sebelumnya sehingga akan tampak suatu kesan yang
nyata. Pemberian material atau texture pada objek 3D akan mendefinisikan rupa dan
jenis bahan dari objek 3D. Material atau texture dapat berupa foto atau gambar yang
dibuat dengan aplikasi software 3D, seperti 3ds max, Maya, dan lain-lain, atau dengan
bantuan software digital imaging, seperti photoshop, photoPaint, atau Gimp. Pada
proses texturing usahakan mencari texture yang memiiki detail yang tinggi agar hasil
yang diberikan juga maksimal.

C. PRAKTIKUM

Silahkan buka aplikasi Blender, silahkan obyek buku pada praktikum sebelumnya
seperti yang terlihat pada gambar dibawah ini.

Silahkan download image cover buku pada web penyedia gambar gratis freepik.com,
gunakan kata kunci “book cover”, hasil pencarian kata kunci akan ditampilkan seperti
gambar di bawah ini.



Pilihlah cover buku yang sesuai dengan pilihan kalian, setelah itu tinggal download
gambar. Langkah selanjutnya kita akan memulai membuat texturing buku, pastikan
dulu anda sedang dalam mode edit seperti yang terlihat pada gambar di bawah ini.

Selanjutnya pilih menuMaterial Properties, setelah itu klik New seperti yang bisa
anda lihat pada gambar di atas. Setelah anda pilih new maka akan menampilkan menu
seperti yang terlihat pada gambar di bawah ini.



Pada bagian Base Color kalian klik tepat pada lingkaran kuning seperti yang
ditunjukkan gambar di atas. Silahkan pilih image texture seperti yang terlihat pada
gambar di bawah ini.



Langkah selanjutnya pilih Open, seperti yang terlihat pada gambar di bawah ini.

Pilih lokasi file download gambar tadi, setelah dipilih filenya klik Open Image
seperti yang terlihat pada gambar di bawah ini.

Untuk melihat hasil texturing buku, silahkan klik Viewport Shading seperti yang
terlihat gambar di bawah.



Untuk merapikan semua sisi silahkan pilih UV Editing, terdapat 2 sisi tampilan, yaitu
tampilan textur dan tampilan obyek 3D nya. Pastikan pada bagian textur anda
memilih image cover buku agar bisa tampil seperti yang terlihat pada gambar di
bawah ini.

Sekarang cobalah pada bagian obyek 3D seperti, aktifkan menu Face Select, setelah
menu aktif arahkan kursor pada salah satu sisi obyek 3D buku, saat sisi yang dipilih
tersebut aktif, maka pada sisi textur akan memperlihatkan batasan textur yang
menutupi buku yang telah dipilih tadi seperti yang terlihat pada gambar di bawah ini.



Pada bagian textur silahkan gunakan tool geser, merubah ukuran dan memutar agar
cover buku menjadi rapi.

D. LATIHAN

1. Silahkan tambahkan textur cover pada obyek 3D buku.

2. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 9 : Lighting Buku di Blender 3D

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat lighting obyek buku dengan aplikasi Blender.

B. MATERI

Lighting adalah proses pembuatan dan pemberian cahaya pada model sehingga
diperoleh kesan visual yang realistis karena terdapat kesan kedalaman ruang dan
pembayangan (Shadow) objek. Tanpa adanya lighting, maka objek 3D anda menjadi
tidak menarik dan juga tidak realistis. Sebuah rancangan bangun ruang 3D
menerapkan beberapa lighting pada tiap sudut ruangan. Hal ini dapat dijadikan
simulasi dalam menentukan cahaya lampu yang nanti digunakan dalam sebuah
ruangan yang nyata.

Selain untuk melihat simulasi pencahayaan ruangan, Menurut Deru dkk (2005)
lighting menjadi faktor penting sebuah kondisi lingkungan dalam ruangan. Performa
pencahayaan bergantung pada beberapa faktor, seperti biaya energi, penghematan
energi, penerangan, dan konsumsi energi. Pencahayaan juga dapat mempengaruhi
kondisi warna dinding atau interior dalam ruangan.

Dalam sebuah software pengolah 3D, terdapat pengaturan pencahayaan yang bisa
disesuaikan dengan keadaan yang diinginkan, berikut gambar mengubah opsi Spot
untuk mengubah tampilan spotlight seperti yang ditampilkan di 3D Viewport yang
dikutip dari situs resmi blender www.blender.org.



C. PRAKTIKUM

Silahkan buka aplikasi Blender, silahkan obyek buku pada praktikum sebelumnya
seperti yang terlihat pada gambar dibawah ini.

Silahkan tambahkan obyek cube yang digunakan sebagai ruangan dari buku, jadi
kesannya buku ada dalam sebuah kotak ruangan, pilih Add > Mesh > Cube seperti
yang terlihat pada gambar di bawah ini.



Silahkan atur besar scale dan geser move kotak seperti yang terlihat pada gambar
dibawah ini.

Atur seakan-akan buku berada tepat di dalam kotak (ruangan), silahkan pilih mode
Toogle X-Ray agar mudah melihat posisi buku di dalam kotak seperti yang terlihat
pada gambar di bawah ini.

Sekarang geser bola mouse keatas agar bisa zoom view buku, yang ada dalam kotak
lalu pilih Viewport Shading seperti yang terlihat pada gambar di bawah ini.



Sekarang pilih light, pada bagian kanan ada menu pengaturan light yang bisa kalian
sesuaikan misalnya memberi efek shadow atau mengubah warna cahaya. Silahkan
coba geser light ke kanan atau ke kiri dan kalian bisa melihat bayangan yang di
hasilkan seperti yang terlihat pda gambar di bawah ini.

D. LATIHAN

1. Silahkan tambahkan pencahayaan dalam sebuah ruangan.

2. Cobalah tambahkan 1 buah cahaya dengan warna biru atau hijau.

3. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 10 : Rendering Obyek di Blender 3D

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu membuat Rendering obyek 3D dengan aplikasi Blender.

B. MATERI

Render atau Rendering adalah proses akhir dari pembuatan animasi 3D, animasi yang
telah dibikin ditambahkan warna cahaya, bayangan dan sudut pandang yang nyata.
Sehingga menghasilkan animasi yang tampak seperti sebuah obyek yang nyata.
Rendering juga digunakan untuk menggabungkan beberapa animasi yang telah diberi
efek seperti cahaya. Aplikasi Blender memiliki tiga mode rendering yaitu render
image, render animation dan render audio.

Proses rendering yang umum adalah proses mengubah obyek 3 dimensi ke format
gambar (misalnya JPG, BMP, GIF dan lain-lain). Sedangkan Proses rendering dapat
menghabiskan banyak waktu untuk render adalah saat render animasi 3D, semakin
detail atau semakin banyak jumlah texture yang digunakan maka semakin banyak
waktu yang dibutuhkan serta hasil render akan berukuran besar.

Pada dasarnya rendering adalah proses akhir dalam pembuatan animasi maupun video,
proses ini menggabungkan beberapa frame yang sebelumnya terpisah kemudian
dijadikan satu sehingga menghasilkan output dalam satu kesatuan. Sebelum tahap
rendering adalah proses texturing pada obyek, dilanjutkan proses pencahayaan agar
kesan obyek 3D yang dibuat akan semakin terlihat detail dan realistik. Semakin detail
obyek maka proses rendering akan semakin lama. Dibutuhkan komputer dengan
spesifikasi yang tinggi untuk melakukan proses rendering agar proses rendering dapat
berjalan dengan lancar dan tidak membutuhkan waktu yang lama.

C. PRAKTIKUM

Silahkan buka aplikasi Blender, silahkan buat 3 buah bola yang berbeda ukuran, pilih
Add > Mesh > UV Sphere, tekan huruf S dan gerakkan mouse untuk memperbesar
atau memperkecil obyek, letakkan bola secara berjajar dan berilah alas plane seperti
yang terlihat pada gambar di bawah ini.



Arahkan kursor pada obyek 3D, klik kanan lalu pilih Shade Smooth yang fungsinya
untuk memperhalus permukaan bola.

Selanjutnya kita akan download environtment terlebih dahulu, silahkan kunjungi
www.hdrihaven.com seperti yang terlihat pada gambar berikut ini.

http://www.hdrihaven.com


Pilih menu HDRis, lalu pilih yang ruangan Indoor, silahkan pilih salah satu gambar
dan download, disarankan download yang 2k atau 4k.

Langkah berikutnya silahkan pilihWorld Properties, klik warna kuning pada bagian
Color. Lalu pilih Environment Texture seperti yang terlihat pada gambar berikut ini.



Silhkan pilih New, dan pilihlah file hasil download tadi, klik Open Image dan
silahkan lihat hasilnya dengan memilih Viewport Shading seperti yang terlihat pada
gambar di bawah ini

Selanjutnya pilih salah satu bola terlebih dahulu, buka menu Material Properties,
lalu klik new untuk membuat texturing pada bola.



Pada bagian Rougness silahkan edit menjadi 0,1 agar bola menjadi berkilau.

Untuk melihat hasil rendernya, atur dulu kamera, pilih kamera arahkan dengan
menggunakan fitur move dan rotate. Ganti dulu Viewport Shading agar mudah dalam
mengatur kamera seperti yang terlihat pada gambar di bawah ini.



Silahkan buka menu Render > Render Image untuk melihat hasil penempatan
kamera dan hasil render.

Atur kamera sampai obyek terlihat semua atau berada di tengah-tengah seperti yang
terlihat pada gambar di bawah ini.



Silahkan klik menu image, lalu pilih save untuk menyimpan gambar hasil render.

D. LATIHAN

1. Silahkan buat 3 buah bola, buat 3 material propertis (untuk tiap bola).

2. Berilah warna yang berbeda untuk masing-masing bola (ubah base color).

3. Gambar hasil render dikumpulkan juga.

4. Screenshot langkahnya dalam bentuk laporan.



Pertemuan 11 : Aplikasi Digital Asset Management

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu memahami dan memanfaatkan Aplikasi DAM.

B. MATERI

Dalam era digital sekarang ini, didukung dengan perkembangan teknologi yang
berkembang pesat. Aset digital sudah selayaknya disimpan dan dipelihara dengan
baik. Penggunaan Software atau aplikasi Digital Asset Management (DAM) sudah
banyak diterapkan oleh banyak instansi atau perusahaan dalam rangka memelihara
aset digital. Menurut Saridewi (2012), DAM adalah proses menyimpan, mengambil
dan mendistribusikan aset digital, seperti logo, foto, dokumen dan file multimedia
dalam sistem terpusat dan terorganisir secara sistematis, yang memungkinkan untuk
penyimpanan temu kembali, dan penggunaan kembali file digital yang dibutuhkan
secara cepat dan efisien untuk semua aktifitas bisnis.

Penggunaan DAM tidak hanya di perusahaan komersil, tapi juga bisa diterapkan
di instansi pendidikan. Menurut Ramadhani dkk (2015), Digital Asset Management
dapat meningkatkan kecepatan dalam pencarian dan menghemat penyimpanan karya
siswa di sekolah. Banyak aset dari sekolah atau universitas yang bisa dimanfaatkan di
masa yang akan datang seperti karya siswa atau skripsi mahasiswa. Konsep penting
dalam DAM adalah aset, sedangkan aset biasanya berkaitan dengan kepemilikan.
Hubungan antara aset dengan kepemilikan dapat diterapkan pada konten media digital.
Jika suatu institusi memiliki hak intelektual atas konten suatu media digital, maka
konten tersebut merupakan aset bagi institusi (Furau’ki & Sukmana, 2018).

Manfaat Digital Asset Management.

Menurut Furau’ki & Sukmana (2018), tujuan yang ingin dicapai dengan
menerapkan konsep penyimpanan aset dengan konsep Digital Asset Management
adalah sebagai berikut :

1. Menjaga dan mengelola kepemilikan aset.

2. Menjamin otentikasi dan integriti data atau dokumen.

3. Menggunakan ulang isi data digital.

4. Meningkatkan pengelolaan yang lebih efisien terhadap aset, untuk mencapai
produktivitas dan keuntungan.

5. Melindungi integrasi data dalam penyimpanan dan pengiriman.

6. Meningkatkan kecepatan akses terhadap aset digital yang dimiliki.



C. PRAKTIKUM

Silahkan buka https://cloudinary.com/ pada web browser kalian, Claudinary adalah
salah satu perusahaan jasa pelayanan untuk membuat aplikasi Digital Asset
Management. Terdapat versi gratis yang bisa digunakan dengan baik walaupun
tentunya tidak selengkap versi yang berbayar.

Silahkan pilih Sign Up For Free untuk mendapatkan akun unntuk login ke dalam
aplikasi. Berikut tampilan gambar mendaftar akun Cloudinary.

https://cloudinary.com/


Selesaikan form pendaftaran, pada bagian Assigned Cloud Name anda bisa edit
namanya dan bagian yang ada keterangan (Optional) silahkan kosongi saja. Setelah
selesai semua silahkan klik Create Account seperti yang terlihat pada gambar di
bawah ini.

Setelah selesai maka akan ada halaman yang menandakan proses registrasi akun
kalian telah selesai dan diminta cek email untuk verifikasi.



Setelah klik url untuk validasi email, kalian akan otomatis masuk ke halaman
dashboard aplikasi Cloudinary, silahkan pilih pada bagian main roleMedia Manager
lalu klik next.

Klik Next saja terus sampai pada bagian Ready to start



Aplikasi DAM dari Claudinary siap dipakai

D. LATIHAN

1. Silahkan bikin registrasi akun di Claudinary.

2. Beri Cloud Name dengan nama kalian masing-masing.

3. Screenshot langkah langkahnya dalam bentuk laporan.



Pertemuan 12 : Managemen File Aplikasi DAM

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu memanajemen file di Aplikasi DAM.

B. MATERI

Tahapan Digital Asset Management

Tahapan Create

 Membuat aset digital dari data analog menjadi data digital, misalnya scan
dokumen.

 Membuat salinan dari media digital misalnya salinan video profil perusahaan.

 Mengunggah media digital ke dalam sistem DAM.

 Mendesain klasifikasi media digital.

 Mendesain penamaan media digital.



C. PRAKTIKUM

Silahkan login di https://cloudinary.com/ pada web browser kalian.

https://cloudinary.com/


Silahkan pilih menu Media Library, maka kalian akan masuk ke halaman yang
menampilkan semua media digital kalian. Silahkan membuat dulu folder yang
digunakan untuk memilah jenis media. Klik gambar folder sebelah tulisan home
seperti yangditunjukkan panah pada gambar di bawah ini.

Berilah nama folder disesuaikan dengan jenis file seperti yang terlihat pada gambar di
bawah ini.



Silahkan buka folder yang telah dibuat tadi, kalian bisa mengupload file dengan
menarik file dari file explorer Windows, atau dengan menekan tombol Upload seperti
yang terlihat pada gambar di bawah ini.

Kalian juga bisa memasukkan file yang sudah terupload tapi masih berada di luar
folder, centang dulu file yang mau dipindah, lalu pilih menu Move to Folder seperti
yang terlihat pada gambar di bawah ini.



Langkah selanjutnya adalah mengganti nama file agar seragam dalam klasifikasi,
silahkan pilih menu edit pada file atau media yang ingin diubah filenya, perhatikan
gambar di bawah ini

Silahkan klik Menu Rename, lalu berilah nama baru yag sesuai, setelah selesai klik
tanda centang seperti yang ditunjukkan tanda panah pada gambar berikut ini untuk
menyimpan perubahan nama yang kalian berikan.



D. LATIHAN

1. Silahkan upload semua media tugas praktikum ke dalam Aplikasi DAM.

2. Buat klasifikasi folder dan nama file yang sesuai.

3. Screenshot langkah langkahnya dalam bentuk laporan.



Pertemuan 13 : Daur Hidup DAM

A. TUJUAN PEMBELAJARAN

Mahasiswa mampu Menerapkan daur hidup DAM pada aplikasi.

B. MATERI

Tahapan Digital Asset Management

Tahapan Manage

 Membuat metadata dari media digital.

 Memberikan keterangan pada media digital.

 Memberikan tag pada media digital.

Tahapan Distribution

 Membagikan tautan lokasi media digital

 Mengirimkan tautan lokasi media digital

Tahapan Retrieve

 Menemukan file dengan mudah.

 Mencari file dengan klasifikasi tertentu secara cepat.

 Menggunakan kembali media digital (tidak terbengkalai).



Tahapan Archive

 Preservasi atau melestarikan media digital.

 Back up keseluruhan media digital terutama data penting.

 Melihat batas waktu penggunaan media digital, misalnya poster pengumuman.

C. PRAKTIKUM

Tahapan Manage

Silahkan buka Setting dan pilih menuManage Structured Metadata seperti yang
terlihat pada gambar di bawah ini.

Pilih Create a new field untuk membuat struktur metadata baru, berikut ini contoh
membuat metadata baru untuk sumber gambar. Setelah memberi nama, pilih tipe
field isian lalu klik Create.



Langkah selanjutnya masukkan sumber gambar satu per satu, misalnya dari Freepik,
Pexels atau None, untuk default value pilih saja none seperti yang terlihat pada
gambar di bawah ini.

Bikin lagi baru misalkan metadata untuk terbitan pilih Create a new field untuk
membuat struktur metadata baru, lalu pilih bagian Date lalu Create.

Biarkan isian kosong untuk setting tanggal. Untuk Mandatory field jika diaktifkan
maka untuk metadata tersebut nantinya wajib untuk diisi.



Sekarang buka media library lalu buka file yang ingin di manage, klik menu manage
seperti gambar di bawah ini.

Pada bagian Summary beri tags untuk kategori media tersebut.



Buka bagian Metadata lalu sesuaikan dengan informasi dari media tersebut.

Tahapan Distribution

Pada bagian menu Copy URL kalian bisa membagikan lokasi dari media digital agar
bisa dibuka pada browser. Kalian bisa pasang URL agar media dapat diakses di CMS
kalian.

Tahapan Retrieve

Pada tahapan ini ketepatan dan kecepatan pencarian media digital yang memiliki
jenis bermacam-macam dan juga jumlah yang mungkin ada ribuan lebih akan sedikit
menyulitkan menemukan file media yang diinginkan. Dengan pengisian tags, nama,
format dan sebagainya akan mempermudah dalam pencarian yang lebih spesifik.



Semisal kalian ingin mencari gambar sampul buku dari sumber Freepik, tinggal
mencari pada bagian metadata disesuaikan dengan setting pencariannya.

Tahapan Archive

Buka menu Setting, pada bagian Upload silahkan pilih Automatic backup menjadi
Enabled lalu klik Save pada menu di bagian bawah.



D. LATIHAN

1. Silahkan buat 5 field untuk struktur metadata. (cukup 2 saja yang di screenshot
langkahnya)

2. Berikan Structured metadata dan Contextual metadata pada seluruh file kalian
(cukup 2 saja yang di screenshot langkahnya)

3. Screenshot langkah dalam bentuk laporan.


	D.LATIHAN

